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Preface This tutorial is designed to get you started quick and easy with Vectorworks interiorcad 
and to introduce you to its intuitive interface. When you have completed this course, you 
will be able to use Vectorworks interiorcad for customer presentations.

The goal/aim of this quick start course is to show you the basic features of Vectorworks 
interiorcad and interior xs, using examples for each. In the course, we will design and 
furnish the entrance area of a doctor’s surgery and create a photo-realistic image of it. To 
keep language simple, we ony use the name Vectorworks interiorcad.

The methods shown in this course are only some of many ways of designing and planning 
the project in question with Vectorworks interiorcad. All commands and tools used in the 
course are explained in short texts. The small steps for each stage of the project are 
numbered and the numbers can also be found in the corresponding screnshots. 

For more detailed explanations of all features and commands, please refer to the manuals 
and the Vectorworks help within the program.

Please see our website www.extragroup.de for more information about Vectorworks inte-
riorcad as well as dates of upcoming seminars and workshops. 

Enjoy your introduction to Vectorworks interiorcad!
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Syllabus In this «Beginners’ Quick Start Course», you will...

• …design the room shown below, complete with windows and doors.

• …paste in the reception table as a symbol.

• …paste a previously created cabinet and adjust it to the room situation.

• …design and paste a simple cabinet.

• …paste more things from the library into the room.

• …set lights and render a photo-realistic image.
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1 Before you 
start…

• …we will tell you the system requirements for Vectorworks.

• …the pictograms used in the text will be explained.

• …you will learn about the „Vectorworks Help“.

• …we will give you an overview of the tools and terms used in the course.

• …we will show you the most important keyboard shortcuts.

• …we will show you how to zoom and move in 2D and 3D spaces.

System requirements • We use «Vectorworks interiorcad 2012» or «Vectorworks interior xs 2012» and 
«Renderworks 2012» for this course. If your interiorcad or interior xs module is based 
on Vectorworks Architect, you can work through the whole course. If your interior xs is 
based on Vectorworks Basic, you cannot use chapter 2. If you are not a Vectorworks 
customer already, please use our demo DVD and install the demo versions of the 
required software.

• Vectorworks interiorcad should be configured according o the standard configuration 
of the installer.

• We recommend a screen resolution of 1280 x 1024 pixels or more.

• If possible, use a wheel mouse.

• You should have basic knowledge of your operating system and know the names of the 
keys on the keyboard.

• The course was designed using the Windows version of Vectorworks. Keyboard shortcuts 
may differ from those for Mac OS X. Please refer to the manuals for further informa-
tion.

Pictograms Important paragraphs are marked with one of the following pictograms:

p In paragraphs marked with this symbol, different methods of executing a 
command are described.

o Important information that shouldn’t be overlooked is marked by the warning 
triangle.

n The light bulb marks tips and advice.
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Workspaces The arrangement of the screen is created by so-called «workspaces». The workspace 
shown below is called «interiorcad». 

If your screen division looks different, you can choose the workspace by selecting «Tools 
> Workspaces > interiorcad»..

The «Basic» palette contains the most frequently used standard drawing tools. It is situ-
ated directly to the left of the drawing. All other tools are grouped into tool sets.

n If you have trouble finding a palette or tool during the course, simply refer o this 
page.

View bar

Navigation
palette

Object Info palette

Attributes palet

Tool bar

(Basic palette)
Standard tools

s palette
Snapping palette

Drawing
Area
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Palettes / Tool sets You can draw the palettes and tool sets from their docked positions at the margin and 
place them anywhere on the drawing. Simply grab a palette at the top edge and draw it to 
the desired location. To draw a tool set from the tool sets palette, just drag the tool set bar 
onto the drawing.

You can show and hide the palettes via the menu «Window > Palettes» as desired.

Help In Vectorworks interiorcad you can access the entire manual in electronic form. Select 
«Vectorworks Help» from the «Help» menu or press «F1», then select the rele-
vant chapter.

Please note that information about basic features, like drawing simple geometric shapes, 
can be found in the «Vectorworks Pro» manual.

To access the help entry for a tool or command directly, select «What’s This?» from the 
«Help» menu and then click the tool or command.

Further help is available by resting the cursor on a tool. Click the gray arrow in the help 
text field to display a short helptext including name and brief description of the tool as 
well as a reference to the relevant manual page.

Many dialog windows also show short help texts at the bottom when you drag the cursor 
over a tool.
 Beginners’ Quick Start Course – Before you start… 7
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Keyboard shortcuts All commands and tools can be accessed via the menu bar or clicking the relevant buttons 
in the tool sets. However, you may quickly discover that keyboard shortcuts are the most 
comfortable and, more importantly, fastest way of accessing frequently used features.

o For key combinations (e.g. „Ctrl+C“), you press the «C» key while holding down 
«Ctrl».

n The keyboard shortcuts can be seen in the menus behind the relevant commands 
(e.g. «Ctrl+X»).

n In the palettes, the shortcuts are shown at the end of the yellow pop-up tool tips.

o To undo a step, select  «Edit > Undo» (or press «Ctrl+Z»). If you have undone 
too many steps, use «Edit > Redo» (or press «Ctrl+Y») to redo them. Select 
«Tools > Options > Vectorworks Preferences» to define the maximum number of 
undos on the «Session» tab. Vectorworks supports up to 100 undo steps.

Zoom There are different ways to zoom in on and out of the drawing. If you are using a wheel 
mouse, you can roll the wheel up and down to zoom in and out - any time, no matter 
which tool is activated.

Move Detail To see a different part of the drawing, hold down the mouse wheel. This activates the tool 
«Pan». The mouse cursor changes into a hand  and you can move the whole 
drawing around on the screen. When you let go of the mouse, Vectorworks returns to the 
previously selected tool and you can continue drawing.

p If you are using a mouse without a wheel, press down the «Space» bar to activate 
the hand cursor.

o

o

o
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Fit to Page Area Press «Ctrl+4» to display the drawing so that it fits exactly into the drawing window. 

p The same effect can be achieved via the button «Fit to Page Area » in the View 
bar.

n This command, as well as zooming and «Pan» only change the screen display of 
the drawing, not its actual size. They do not affect the size of printouts.

Top/Plan Press «Ctrl+5» to access the Top/Plan view. In this view, three-dimensional objects are 
displayed as viewed from above. Objects that have both a 2D and a 3D component (such 
as windows, doors, walls etc.) are only displayed as 2D objects.

The views of the chair below illustrate the difference between different view modes:

3D views Use the «Views» palette to access the most important 3D standard views. Selecting one of 
the views also selects the tool «3D Selection».

p You can also access the standard views via the relevant commands in the menu 
«View > Standard views».

n If the screen looks irregular - mostly, that is due to graphics card difficulties - press 
«Y» twice to reload the contents of the drawing window.

+

+

Top/Plan 3D view «from the top»
 Beginners’ Quick Start Course – Before you start… 9
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Template and Basic
Preferences

There are two ways of completing this course. We recommend working hrough the 
course from start to finish. Alternatively, you can skip part 1 Spatial Planning and start 
from page 43 with chapter 3 „Furniture and interior fittings“. 

1 Close all active documents before opening a template. To do so, use «Ctrl+W» or 
select «Close» from the «File» menu.

2 Select «New» from the «File» menu.

3 Select «Use document template».

4 Select the desired template from the pull-down menu. 

5 Click «OK» to confirm.

n The gray frame is not printed. It marks the printable area. Its size depends your 
printer.

Now we should have the basic preferences needed to carry out the exercise.

n From time to time, you should save your progress in a file. To do so, use «File > 
Save» or press «Ctrl+S».

p

5

Select the template «interiorcad - 
Quick Start Course chapter 2.sta» 
to start the course from the beginning.

Select the template «interiorcad - 
Quick Start Course chapter 3.sta»
to start from the end of the chapter 
«Spatial Planning»

3

4
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2 Spatial Planning In this part of the course, we will…

• …draw a floor plan step by step.

• …place straight walls along the floor plan and create a rounded wall.

• …insert the entrance door and the two inner doors.

• …insert and position windows.

• …create ceiling and floor for the room and allocate textures in preparation of the 
photo-realistic image.

The result of this part of the course is the room shown below.
 Beginners’ Quick Start Course – Spatial Planning 11
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Floor Plan The floor plan of the room is to look like this:

7000

6
00

0

3000

3
00

0

4000

3
00

0

2200

2
20

0

R 2000
Beginners’ Quick Start Course – Spatial Planning



 

Rectangle We start by drawing the room as a rectangle.

1 Select the «Rectangle » tool from the «Basic» palette.

2 Click on the top left of your drawing. (Click 1)

3 Draw a rectangle.

4 Click again to close the rectangle. (Click 2)

5 Press the «X» key to exit the «Rectangle» tool. The rectangle just drawn remains 
selected.

6 Enter «7000» mm as the height of the rectangle in the «±x» box in the «Object 
info» palette and press «Enter» to confirm.

7 The height of the rectangle is «6000» mm. Enter this value into the «±y» box and 
press «Enter» to confirm.

We will now place the rectangle in the middle of the drawing.

8 Select the «2D Selection» tool .

9 Move the mouse cursor onto the rectangle and hold down the left mouse key 
while dragging it to the middle of the drawing. It doesn’t have to be the exact middle, 
so we will not do an exact positioning at this stage.

Click 1

Click 2

7

6
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Room corner 1 Double-click the «Rectangle » tool from the «Basic» palette.

2 Enter «4000» x «3000» mm as the rectangle’s dimensions.

3 The point of insertion should be at the bottom left relative to the rectangle. Click the 
symbolic point in the object info to define the point of insertion.

4 Check the box «Position At Next Click». The rectangle’s insertion point is then 
defined by the first click after confirming the dialog.

5 Click «OK» to confirm.

The cursor changes into a crosshairs.

n Adjust the mouse snap in the «Snapping» palette. If the snappings are not adjusted 
according to the screenshot below, activate them by clicking.

6 Move the crosshairs over the bottom left corner of the larger rectangle in the drawing. 
Wait until the Intelligent Cursor displays the cue «Bottom Left», then click.

4

5

2

3
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Clip Surface We will now select both rectangles.

1 Press «X» to select «2D Selection ».

o Pressing «X» exits any active command or tool and selects the default tool «2D 
Selection», the starting point for many commands and tools.

2 If the smaller rectangle is not selected anymore, click its edge to select it.

n An active object is displayed with eight modification points and highlighted in 
orange.

3 Hold down Shift (4) and click the larger rectangle to add it to the selection.

o Make sure not to press «Ctrl» instead of «Shift», as this would result in a copy of 
the object being produced (see «Move copy» in the Vectorworks manual).

The Object Info palette shows that both rectangles are selected.

4 Select «Modify >Clip Surface». 

5 Now only the smaller rectangle is selected. Press Del to delete it.

The result is a polygon.

o
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Chamfer corner Now we will chamfer the room’s inner corner.

1 Select the «Chamfer » tool from the «Basic» palette.

2 Select the third tool method («Chamfer and Trim Mode») from the Tool bar.

3 Click the «Preferences» button in the Tool bar.

The dialog «Chamfer Preferences» opens.

4 Select «First and Second Lines».

5 Enter «2200» mm in both input boxes.

6 Click «OK» to confirm.

5

5

4

6
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7 Click the horizontal line at the room corner. (Click 1)

n You do not have to hit the line exactly. As soon as the cursor changes into a little 
cross, you can click. Also, it doesn’t matter where you start the chamfering. The 
measurements are defined only by the preferences in the Tool bar (see above).

8 Then click the vertical line. (Click 2)

n «Click 1» and «Click 2» define which line is the «First Line» and which one is the 
«Second Line». Since our example has an equilateral chamfer, the order of 
clicking the lines does not matter.

The corner is chamfered according to the previously defined measurements.

9 Press «X» to exit the «Chamfer» tool.

Click 1

Click 2
 Beginners’ Quick Start Course – Spatial Planning 17
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Walls In the next step, we will create walls around the outside of the floor plan. The floor plan 
that we just created shows the clear dimensions of the room.

This floor plan will be deleted after creating the rounded wall.

1 Select the «Wall » tool from the «Building Shell» tool set.

A wall with fitting parameters is already integrated into the template:

2 Select the wall style «VWI Beginners’ Quick Start Course» from the Tool bar 
at the top.

Now we place the straight walls clockwise along the floor plan.

3 Move the cursor to the top left corner of the polygon. Click when the cue «Point» is 
displayed. (Click 1)

The walls should be to the left of the floor plan line so that they are always on the outside 
of the floor plan. This setting is made on the Tool bar.

4 Press «u» repeatedly to set the mode to «Right Control Line Mode » ein.

n The shortcut «u» changes between the modes on the Tool bar for every tool. With 
the Wall tool, you can also see its effect when you look at how the wall’s positioning 
and orientation changes as you press «u».

1

Click 1
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5 Now move the cursor to the top right corner of the floor plan and click when the cue 
«Point» is displayed. (Click 2)

The first wall has now been placed.

n You will need eight clicks in total to draw all the walls. If you click in a wrong spot, 
use Backspace or Del to undo only the last step without aborting the whole drawing 
process. This method also works for polylines, polygons and dimensions.

6 Click again as shown above to place all the walls.
(Clicks 3 through 8)

When you have arrived at the starting point again (Click 8), the walls are closed.

The Object Info palette shows that seven walls have been created.

7 Press «X» to exit the Wall tool.

3

Click 2

4

5

67

8
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Filleted Corner The next step is to add a filleted corner to the room.

1 Select the «Fillet » tool fom the «Basic» palette.

2 Select the third mode «Fillet and Trim Mode» on the Tool bar.

3 Then click the «Preferences» button in the Tool bar.

The «Fillet Preferences» dialog pops up.

4 The filleted corner is to have a radius of «2000» mm.

5 Click «OK» to confirm.

n The «Fillet» tool works the same way as the Chamfer tool.

6 Click on the horizontal wall near the top right room corner. (Click 1)

7 Then click the right vertical wall. (Click 2)

8 Press «X» to exit the Fillet tool.

Delete Floor Plan The floor plan (polygon) we drew previously now protrudes the filleted edge. Since it is 
now underneath the walls, it is not needed any more.

1 Deselect all objects that may be selected by clicking an empty spot on the 
drawing outside the room.

2 Select the floor plan by clicking the polygon corner outside the filleted corner.

3 Press Del.

Click 1

Click 2
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Assign Class The walls are now finished. In preparation of the photorealistic rendering at the end of 
the course, we will now assign a class to the walls. The relevant settings are preset in this 
class.

First all walls have to be selected.

4 Move the cursor to the left and above the walls, press the left mouse button and hold 
it down. (Click…)

5 Draw a selection rectangle around all walls and let go of the mouse button. (Let go!)

The Object Info palette shows that eight walls have been selected.

6 Set the class to «Walls» on the «Shape» tab in the Object Info palette.

7 Should a warning dialog open, please click «Yes».

8 Click an empty space in the drawing to deselect all objects.

Click…

Let go!

4
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Add doors Next, we will add and position the doors.

For this beginners’ course, we will use the doors from the template. Make sure that the 
Resource Browser shows the resources of the current document.

1 In the resource browser, click the « » button.

n Check this setting. Make sure that the option «Top Level» is switched on.

n If parts of the resources (here: the category «Symbols/Objects») are not displayed, 
double-click the category or click the gray arrow.

2 Double-click the symbol «Entrance Door» in the Resource Browser.

n A dotted 2D preview of the door becomes visible when you place the mouse cursor 
in the drawing. 

1

Double-click!
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3 Now place the cursor on the chamfered wall.

o Make sure that the mode is set to «Wall Insertion Mode ». Smbols can 
only be added to a wall if this mode is switched on. Also, they will be automatically 
oriented towards the wall.

4 Move the cursor over the center of the wall, shown by the cue «Midpoint».

5 Left-click. (Click 1)

The door is placed on the center of the wall.

Klick 1
 Beginners’ Quick Start Course – Spatial Planning 23
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We want the entrance door to open to the inside and mounted on the right.

6 Move the cursor around the center (insertion point of the door) in a ciruclar motion 
until the preview shows the desired opening direction and mount.

7 Click again. (Click 2)

The door is inserted into the wall, also shown in the Object Info palette.

8 Press «X» to exit inserting the door.

Click 2
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Inner doors Place the inner doors on any place on the left and right walls respectively. Opening direc-
tion, mount and position relative to the wall are adjusted via the Object Info palette after 
placing the doors.

1 Double-click the symbol «Inner door» in the Resource Browser.

2 Move the cursor over the left wall. Make sure that the door aligns itself with the wall 
and double-click to place the wall.

3 Insert another inner door into the right wall.

4 Press «X» to exit inserting the doors.

We first adjust the settings for the right inner door.

1 Select the door in the right wall.

2 Press the button «Flip» in the Object Info palette repeatedly until opening direction 
and mount are adjusted as shown below.

Double-click!

Double-click!

2

Double-click!
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3 Click the button «Set Position» in the Object Info palette and choose the «Refe-
rence Point Mode» in the Tool bar.

.

n We want the opening in the wall to start 625 mm from the inner corner of the wall. 

4 Select the inner corner of the wall as relation point for positioning (cue: «Endpoint»).

3

4

5

6
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5 Select the wand opening (cue: «Endpoint»). Press «Z» to activate the Snap Loupe to 
get a more detailed view around your cursor.

6 Enter «625» into the «Offset» box.

7 Click «OK» to confirm.
 Beginners’ Quick Start Course – Spatial Planning 27
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Now we configure the left inner door.

1 Select the door.

2 Press the button «Flip» repeatedly to adjust opening direction and mount as shown 
below.

3 Click the button «Set Position» in the Object Info palette and choose the «Refe-
rence Point Mode» in the Tool bar.

.

We want the opening in the wall to start 375 mm from the inner wall corner. 

4 Select the inner wall corner as relation point for the positioning (cue: 
«Endpoint»).

2

3

5

6

4
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5 Select the wand opening (cue: «Endpoint»). Press «Z» to activate the Snap Loupe to 
get a more detailed view around your cursor.

6 Enter «375» in the «Offset» box.

7 Click «OK» to confirm.
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Insert windows In the next step, a large multi-winged window is inserted. Three narrow fixed sash window 
elements are inserted into the filleted wall.

We will use the windows already stored within the template for our exercise.

1 Double-click the symbol «Window with Lower Lights» in the Resource Browser.

2 Souble-click to insert the window into the top wall.

3 Press «X» to exit inserting the window.

Double-click!

Double-click!
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Zoom in on the window to check the opening direction.

1 Select the window. If required, click «Flip» repeatedly to adjust the opening direction 
as shown below.

2 Click the button «Set Position» in the Object Info palette and choose the «Refe-
rence Point Mode» in the Tool bar.

We want the opening in the wall to start 625 mm from the inner wall corner.

3 Select the inner wall corner as relation point for the positioning.

4 Select the wand opening. Press «Z» to activate the Snap Loupe to get a more detailed 
view around your cursor.

5 Enter 625 in the «Offset» box.

6 Click «OK» to confirm.

2

4

5

3
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Insert window elements on
the filleted corner

As a last step in designing the room, three fixed sashed window elements are inserted into 
the filleted corner.

1 Zoom in on the filleted corner.

2 Double-click the symbol «Window, fixed sash» in the Resource Browser.

Insert the three windows into the filleted corner as shown. The inserting is done as follows: 

3 Move the cursor onto the wall. Click once when the preview shows that the window has 
taken over the wall’s angle (Click 1). Move the cursor to the inside of the room, away 
from the wall. Click again (Click 2).

4 Repeat for the second and third windows.

5 Press «X» to end inserting the windows.

n If you have inserted the windows the wrong way round, press the button «Flip» in 
the Object Info palette repeatedly, as shown in the previous step.

Double-click!

Click 2

Click 1
Beginners’ Quick Start Course – Spatial Planning



 

Now the elements have to be positioned.

1 Select the central window.

2 Click the button «Set Position» in the Object Info palette and choose the «Refe-
rence Point Mode» in the Tool bar.

3 Select the bottom of the arc (cue: Arc End)as relation point for the positioning.

4 Select the insertation point in the middle of the window (cue: Insertation Point) 
Press «Z» to activate the Snap Loupe to get a more detailed view around your cursor.

5 Enter 45° in the «Angle» box.

6 Click «OK» to confirm.

5

4

3
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The other windows are placed symmetrically on both sides.

1 Select the right window element.

2 Click the button «Set Position» in the Object Info palette and choose the «Refe-
rence Point Mode» in the Tool bar.

3 Select the bottom of the arc (cue: Arc End)as relation point for the positioning.

4 Select the insertation point in the middle of the window (cue: Insertation Point) 
Press «Z» to activate the Snap Loupe to get a more detailed view around your cursor.

5 Enter 22,5° in the «Angle» box.

6 Click «OK» to confirm.

5

4

3
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The left window element has to be positioned correctly.

1 Select the left window.

2 Click the button «Set Position» in the Object Info palette and choose the «Refe-
rence Point Mode» in the Tool bar.

3 Select the top of the arc (cue: Arc End)as relation point for the positioning.

4 Select the insertation point in the middle of the window (cue: «Insertation 
Point») Press «Z» to activate the Snap Loupe to get a more detailed view around your 
cursor.

5 Enter 22,5° in the «Angle» box.

6 Click «OK» to confirm.

Now all doors and windows are placed, we can start the last step of shell building.

7 Press «Strg+4» to display the complete room.

5

4

3
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Floor and ceiling For the photo-realitisc rendering, floor and ceiling of the room are still missing. We will 
design these as extrudes and assign a texture.

1 First, all walls have to be selected. We will not click all the walls on their own, but 
choose «Tools > Custom Selection» and select the options «Select Only» and 
«Execute Immediately.». Then we press the button «Criteria».

2 Choose«Class» is «Walls» in the drop-down menu.

3 Click «OK» to confirm.

All objects belonging to the class «Walls» are selected.

2

2
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The Object Info palette also shows that eight walls are selected.

1 Choose «AEC > Create Polys from Walls».

The «Polys from Walls» dialog opens.

2 Check the box «Gross Area Polys».

3 Click «OK» to confirm.

The polygon is created accordingly.

o In the «Top/Plan» view for floor planning, the objects are displayed in the order 
of their creation. So at the moment, the walls are hidden under the polygon.

4 Press «X» to activate the «2D Selection» tool.

5 Deselect all objects by clicking an empty spot on the drawing.

1

3
2
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The polygon is a 2D element. When we look at the room in 3D, it lays on the ground plane.

We make a small demonstration step to illustrate this. This step is not necessary for 
completing the exercise.

1 Click the button «Right Isometric » in the «Views» palette.

The drawing shows that the polygon is not oriented within 3D space..

For our floor and ceiling, we will need three-dimensional objects which can be assigned 
a texture. In the following, we will therefore create an extrude with a height of 20 mm 
from the polygon.

2 Press «Strg+5» to change to «Top/Plan» view.

Now we can create an extrude from the polygon.

1 Click inside the polygon to select it.

2 Choose «Model > Extrude…».

2
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The «Extrude» dialog opens.

The default x and y values are the polygon’s outer dimensions.

3 Enter «-20» mm in the «±z» box.

n Extrudes are always created from the ground layer upwards - in positive z direc-
tion. By entering a negative z value, the extrude for the floor is created from z=0 
downwards. This way, objects like furniture etc. are inserted on top of the floor, so 
we will not have to shift them upwards.

4 Click «OK» to confirm.

The extrude is created and selected. We assign a texture to the floor.

5 Change to the «Render» tab in the Object Info palette.

6 Select the rendering texture «Floor Reception» from the list.

The floor is finished. 

3

4

6

5
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Next, we will create the ceiling using a copy of the floor.

1 Select the button «Left Isometric » from the «Views» palette.

We have assigned the walls to the class «Walls». The floor is assigned to the class «None» 
because this class was active when we created the floor.

For more clarity, we hide all classes except the active class «None».

n The active class is displayed in the View bar.

2 Choose «Active only «in the «Class Options» drop-down menu in the Naviga-
tion palette.

All objects except the floor are hidden because they are not in the class «None».

3 If the floor is no longer selected, click to select it.

4 Press «Strg+C» to copy the floor to the clipboard.

p You can also call this command via «Edit > Copy».

2
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Now we want to paste the floor from the clipboard in the exact same place to get a dupli-
cate. To do this, we use the Vectorworks command «Paste In Place».

5 Press «Ctrl+Alt+V». (Hold down «Ctrl» and «Alt», then press «v».)

p You can also access this command via «Edit > Paste In Place».

The copy of the floor is inserted in the same place as the original. The Object Info palette 
shows that an extrude has been selected.

The walls are 3000 mm high, so we want to move the extrude to that height.

6 Choose «Modify > Move > Move 3D…» or press «Ctrl+Alt+M».

The «3D Move» dialog opens.

7 Enter «3020» mm in the «±z» box.

8 Click «OK» to confirm.

5

6

7

8
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The extrude is moved upwards and stays selected.

We assign a texture to the ceiling.

9 Select the texture «Ceiling Reception» on the «Render» tab of the Object Info 
palette.

We can now show all classes again.

10 Choose «Show/Snap/Modify Others» in the «Class Options» drop-down 
menu in the Navigation Palette.

11 Press «Strg+5» to change to «Top/Plan» view.

12 Save your progress by choosing «File > Save». This feature is disabled in the demo 
version.

9

10
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3 Furniture and 
interior fittings

Now that the «construction work» on our room is done, we can start interior design.

• The reception counter is inserted as a symbol.

• We place four chairs as a waiting area in front of the window.

• A predefined filing cabinet is inserted and adjusted to fit into the situation.

• A predefined array of furnishings, containing e.g. a desk chair and paintings, is inserted 
into the drawing.

When this step is completed, the room will look like this:
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Reception counter First, we add the reception counter, which is stored in the template as a symbol.

n Press «Strg+4» to display the complete room.

1 Double-click the symbol «Reception counter» in the Resource Browser.

The preview around the cursor shows the symbol’s outline in dotted lines. The insertion 
point is displayed as a small cross and is by default the top left corner of the counter.

2 Disable the «Wall Insertion Mode » option on the Tool bar.

o We want to place the counter flush with the top wall, but not into the wall. If «Wall 
Insertion Mode» is switched on, the symbol cannot be inserted in front of the wall, 
but is aligned with the wall.

Double-click!
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To place the counter 3.50 m from the inner corner, we use the Vectorworks command 
„Relative Origin“.

n This feature enables you to temporarily turn any point on the drawing into the zero 
point of the coordinate system.

3 Move the insertion point over the top left inner wall corner until the cue 
«Endpoint» is displayed.

4 Press «g». This is the default shortcut for relative origin.

The coordinates in the bar at the bottom of the screen are set to zero.

5 Move the cursor to the right.

n The relative origin is marked by the text «Datum»
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6 Press the tabulator key (TAB)

A bar with the coordinates is displayed near the cursor.

7 Press the tabulator key (TAB) again.

The cursor jumps to the «x» box.

8 Enter «3500» mm and press the tabulator key (TAB) again to jump to the next 
input box.

The cursor is snapped to 3500 mm from the inner corner in horizontal direction. It may 
now only be moved along the dotted line.

9 Move the insertion point to the inside of the wall between the window and the 
rounded corner. Click when the cue «Object / Vertical» is displayed.

10 Move the cursor around the insertion point until the preview shows the counter’s 
desired position; then click to insert the counter.

11 Press «X» to exit.

8

9

Click!
10
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Place chairs We want to place a row of chairs in front of the window as a waiting area.

1 Zoom in on the area in front of the window.

2 Double-click the symbol «Visitors’ chair» in the Resource Browser.

n The preview around the cursor shows the outer dimensions of the symbol in dotted 
lines. The default insertion point is the top left.

3 Double-click to place the chair roughly in front of the left window wing.

n You do not need to be exact in your positioning of the chair. Just keep in mind that 
there will be a cabinet of 500 mm depth in the left corner of the room, and that 
there needs to be space for three more chairs to the right.

4 Press «X» to exit and place the chair.

5 Select the chair.

6 Choose «Edit > Duplicate Array...».

p This command can also be accessed by pressing «Ctrl+Shift + Alt+D» or «Ctrl + 
Shift + D» depending on your workspace.

Double-click!

Double-click!

6
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The «Duplicate Array» dialog opens.

1 Select «Linear Array».

2 We want to make «3» copies of the chair.

3 The distance between the copies is to be determined by «Cartesian Offset».

4 Enter «600» mm in the «x» box.

5 Check the «Retain» box.

6 Click «OK» to confirm.

The other chairs are inserted.

n Press «Ctrl+4» to display the complete room.

1

4

3 2

6

5
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Filing Cabinet You do not have to design frequently used standard cabinets from scratch for every new 
order. Vectorworks interiorcad allows you to reuse predefined designs. Just make some 
adjustments to their settings, and you’ll be able to design your rooms fast and flexible.

A cabient stored in the template is inserted at the bottom right of the niche and adjusted 
to the situation.

1 Zoom in on the niche.

2 Double-click the symbol «Filing Cabinet» in the Resource Browser.

3 Make sure that the option «Wall Insertion Mode » on the Tool bar is switched 
off.

4 Move the insertion point to the inside corner of the wall. Click once when the 
cue «Endpoint» is displayed. (Click 1)

5 Move the cursor to the inside corner of the wall within the niche until the preview of 
the cabinet is in the desired position. Click again. (Click 2)

The filing cabinet is placed in the desired position.

6 Press «X» to exit.

Double-click!

Click 1

Click 2
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In the next step, we are going to modify the filing cabinet.

1 Double-click the filing cabinet to edit it. 

n Make sure to click on one of the lines of the cabinet, not in between the lines, since 
the cabinet is displayed in wireframe (!) mode.

The «Create Unit...» dialog is opened. You are now in the Cabinet Maker.

2 The niche is «3000» mm wide (clear dimension). Adjust the width of the filing 
cabinet by making the necessary correstions in the box marked above.

3 Then click the «Front» button.

1

2

3
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The «Front Design...» dialog opens.

The current settings divide the cabinet into three vertical segments according to the 
formula «1000 0 1000». The left and right segments have a fixed width of 1000 mm, the 
rest of the width is the variable middle segment.

1 To make both the left and right segments wider, enter «1200 0 1200» in the 
«Divide by» box. Make sure to separate the values with a blank space.

2 Click the «Edit» button.

The settings are applied and the preview on the left is adjusted accordingly.

3 Click «OK» to confirm.

3

1

2

 Beginners’ Quick Start Course – Furniture and interior fittings 51



52
You are returned to the «Create Unit…» dialog.

The filing cabinet has a double side on the right a scribe flush with the unit on the left. 
We want to change it so that it has scribes flush with the unit on both sides, so we can fit 
the cabinet into the niche exactly. We make this change in the next step.

1 Click the «Scribes» button.

The «Fillings/Applied Panels…» dialog opens.

2 On the «Left/Right» tab, change the settings in the «Right» area to «Filling is 
flush with unit».

Set dimensions as shown above.

As on the left side, the scribe is to be flush with the plinth’s top edge.

3 Click the scribe and adjust it accordingly.

4 Click «OK» to confirm.

4

3

2
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You are again returned to the cabinet maker’s main dialogs.

We have now made all the necessary adjustments to the filing cabinet. Now we can apply 
them to the drawing.

1 Click the «Change» button at the bottom of the dialog.

The cabinet ist now adjusted and reloaded in the drawing. It is now 3000 mm wide in total 
and has scribes flush with the unit on both sides.

n If no changes becomen visible in the drawing, press «Y» twice to refresh the 
screen.

2 Press «Ctrl+4» to display the whole room.

1
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Place further objects In this step, we will add further objects to our drawing. 

We have already learned how to add objects from the library in the chapter „Place chairs“. 
To avoid spending too much time on this course, we now add an array of objects from the 
library. Amongst other things, this array contains an office chair, a computer with printer, 
and some paintings and plants.

1 You will find the array of objects in the Resource Browser as a symbol called 
«Furnishings». Double-click it.

2 Make sure that the option «Wall Insertion Mode » is switched off.

3 Set the insertion point onto the outer corner of the left wall until the cue «Object» 
is displayed.

4 Double-click here.

The objects are placed in the drawing.

5 Press «X» to exit.

Double-click!

Double-click!
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4 Cabinet Design As already mentioned in the chapter „Place chairs“, the sideboard shown below is to be 
put into the left corner of the wall next to the chairs.

We will design it as follows:

• The sideboard’s basic geometry is not rectangular, but slanted at one side. Therefore, 
this geometry is first drawn as a polygon.

• We will then move the polygon and rotate it to turn it into a cabinet.

• Using the Cabinet Maker, we will design the sideboard:

- The cabinet has a right side and middle shelves. The left outside is left out.

- The sideboard is divided into three segments: On the left, an open segment with 
fixed shelves, on the right and in the middle segments with adjustable shelves and 
layed-on doors.

- The cabinet’s back is 19 mm thick and layed on.

- The cabinet has a plinth and a double finished top.

- The scribe on the right is flush with the unit.

• Finally, we will place the unit in the left wall corner.

o In this chapter, it is extremely important that you execute the steps in their 
numbered order. 
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Create polygon We first draw a polygon with the following dimensions:

The polygon is created from a rectangle which is then chamfered.

1 Zoom in on the top left wall corner.

2 Double-click the «Rectangle » tool .

3 Enter the dimensions «400» x «1400» mm for the rectangle.

4 Set the insertion point to the top left.

5 Check the «Position At Next Click» box.

6 Click «OK» to confirm.

7 Move the cursor to the inner corner of the wall and click when the cue «Enpoint» is 
displayed.

3

4 5

7
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1 Select the «Chamfer » tool from the «Basic» palette.

2 Select the third mode on the Toolbar.

3 Click the «Preferences» button on the Tool bar.

The «Chamfer Preferences» Dialog opens.

4 Select «First And Second Lines».

5 Set the «First Line» to «200» mm.

6 Set the «Second Line» to «300» mm.

7 Click «OK» to confirm.

8 Click the right edge of the rectangle to turn it into the «First Line» of the chamfer. 
(Click 1)

9 Cick the bottom edge as «Second Line» of the chamfer. (Click 2)

10 Press «X» to exit the chamfer tool.

2 3

6

5

4

Click 1

Click 2
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„Unit from polygon...“ We now derive the basic geometry of the unit from the polygon.

1 Press «Ctrl+4» to display the whole room.

2 Select the polygon.

3 Move the cursor over the polygon, press the left mouse button and hold it down. 
(Click…)

4 Move the polygon onto the drawingboard outside the room and let go of the mouse 
button. (Let go!)

5 Press «Strg+L» to rotate the polygon until it looks like the screenshot below.

n The shortcut «Ctrl+L» executes «Rotate Left 90°» (Menu «Modify > Rotate»). 
The object is rotated around its center counter-clockwise.

p There are different ways of rotating an object. If you would like to rotate an object 
around a certain point, you should best use the tool «Rotate » from the 
«Basic» palette.

6 Right-click the polygon.

7 Select «Cabinet from polygon…» from the contextual menu.

Click…

Let go!

7
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The «Assign sides…» dialog is opened.

1 Turn the pull-down menu to „polygon as viewed from «top»“.

n In a later step of design, we want to insert vertical divisions into the sideboard. This 
front design always refers to those lines which are designated the «front».

We assign the slanted line of the sideboard to the front so that later, the front design refers 
to the whole width of the sideboard.

2 To edit this setting, left-click the slanted line.

3 Select «front» from the contextual menu.

4 Press the «Assign» button to exit the dialog.

1

2
3

4
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Overall dimensions You are now in the «Create Unit...» dialog.

1 Name the unit «Sideboard».

We want the polygon resp. an entered height to define the overall dimensions of the unit

2 Select the «Overall dimenions» box.

3 Fill in the height«1000» mm.

4 Click the «Case» button.

2

3

4 1
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Case The «Case…» dialog opens.

Since the left segment of the unit is open to the front and the left, we don’t want a left 
outside panel.

1 Click the left case side in the «Front view» area.

The left side is switched off.

All other settings should be adjusted as shown.

2 Click «OK» to confirm.

2

1
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Back panel

1 Press the «Back» button in the Cabinet Maker’s main dialog.

The fixed shelves of the open left side are to be fixed to both the middle division and the 
back panel. Therefore, the case gets a 19 mm thick butted back panel.

2 Select «Face Fixed Back».

3 Enter «19» mm as back panel thickness.

The back panel is to be flush with the unit on all sides.

4 Set all gaps to «0» mm.

n You can copy the value last entered into one box to another by clicking the  
button.

5 Press «OK» to confirm.

5

2

4

4

3
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Plinth 1 Click the «Plinth» button in the main dialog.

The «Plinth…» dialog is displayed.

2 The plinth is «80» mm high.

3 We want the front left plinth corner to be mitred. Click the join repeatedly to adjust it.

4 The back plinth has a gap of «35» mm.

5 Adjust the other gaps as shown.

6 Click «OK» to confirm.

2

4

3

6

5
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Finished top We want the sideboard to have a finished top.

1 Check the box next to the «Top/Bottom» button in the Cabinet Maker’s main dialog.

2 Click the «Top/Bottom» button to access the «Finished Top/Finished Bottom...» 
dialog.

3 Select the «Finished top» area.

4 The finished top is «25» mm thick.

5 The overlap of the top at the back refers to the back edge of the case sides. Since our 
unit has a butted back which is 19 mm thick, we enter a back overlap of «20» mm.

6 The overlap to the front and left is to be «30» mm.

7 The overlap on the right is also «30» mm.

8 Click «OK» to return to the main dialog.

1

2

8

5

3

6

7

4
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Scribes The right side of the unit has a scribe.

1 Check the «Scribes» box in the Cabinet Maker’s main dialog.

2 Click the «Scribes» button.

3 Check the box «Right»on the «Left/Right» tab.

4 Select «Scribe is flush with unit».

5 The scribe has a «5» mm gap.

6 The scribe is «30» mm thick.

7 The scribe only reaches down to the upper edge of the plinth. Adjust it accordingly by 
clicking.

8 Click «OK» to return to the main dialog.

1

2

4

3

7

8

5

6
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Front Design In the next step, the case is divided by middle sides and shelves and fronts are added.

1 Press the «Front» button in the main dialog.

First, we separate a 220 mm wide segment by a middle side.

2 Select «Vertical division».

3 Enter «2» as number of subsegments.

4 Enter the formula «220 0» in the «Divide by:» box. Make sure to separate the values 
with a space.

n In a division formula, the value «0» resolves to «remainder». In the case of our 
example, the first segment is 220 mm wide and the variable remainder constitutes 
the second segment.

5 Select «Absolute» to make Vectorworks read the values in the «Divide by:» box as 
absolute numbers (in mm).

6 Select «Dividers».

7 Set the dimensions to «Centers».

8 Click the  button to apply the front design settings.

2

8

3

5

4

6

7
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Next, we will subdivide the left segment into three equal horizontal segments..

1 Click the left segment to select it.

n The selected segment is displayed in dark gray.

2 Select «Horizontal division».

3 Select «3» subsegments.

4 You do not need to enter specific measurements. Simply enter the formula «0 0 0» 
into the «Divide by:» box.

5 Select «Equal» to create three equally sized segments.

6 Set the shelves to be «Fixed shelves».

7 Set the dimensions to «Centers».

8 Click the  button to apply the division.

2

8

3

5

4

6

7

1
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The right side of the sideboard is segmented further.

1 Select the right side.

2 Select «Vertical division».

3 Create «2» subsegments.

4 The segment is to be divided at a 2:1 ratio seen from left to right. Enter «2 1» in the 
«Divide by:» box.

5 When you enter a ratio in the «Divide by:» box, the option «Proportional» has to 
be selected.

6 The segment is to be divided by «dividers».

7 Set the dimensions to «Centers».

8 Click the  button to apply the division.

2

8

3

5

4

6

7

1
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The middle segment gets an adjustable shelf.

1 Select the middle part.

2 Select «Horizontal division».

3 Create «2» subsegments.

4 We want the segment to be divided 70% top to 30% bottom. Enter the formula «70 
30» into the «Divide by:» box.

5 Select the «Percentage» option.

6 Select «Shelves» as division.

7 Set the dimensions to «Centers».

8 Click the  button to apply the division.

2

8

3

5

4

6

7
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The right segment is to have three shelf divisions; the lower three with a height (clear 
dimension) of 330 mm (A4 lever arch files).

1 Select the right segment.

2 Select «Horizontal division».

3 The segment is to have «3» subdivisions.

4 Enter «330 330 0» in the «Divide by:» box.

n This formula assigns a height of 330 mm to both lower segments. The top segment 
takes up the remaining height.

5 Select «Absolute».

6 Select «Shelves» as dividers.

7 Set the dimensions to «Centers».

8 Click the  button to apply the division.

2

8

3

5

4

6

7

1
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The middle segment is covered by a double door.

1 Click one of the segments in the middle part of the sideboard.

2 Click the  button to select the enclosing segment.

3 Change to the «Front» tab.

4 Check the box in front of the «Door » button.

5 Click the «Door» button.

5

1

2

3

4
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Door The «Door…» dialog opens.

1 Select «Double door».

2 Select «Layed-on doors».

3 Make sure that the option «Hinged doors» is selected.

Adjust all other settings and dimensions as shown.

4 Change to the «Handle» tab.

1

4

2 3
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We will now place handles onto the double doors. 

1 Select the handle «_11235».

2 Click the preview to place the handle in the top left and right corners of the doors.

n You can place the handle at any spot on the front. Clicking the same spot repea-
tedly will rotate the handle.

3 Set the horizontal offset of the handle to «50» mm.

4 Set the vertical offset to «50» mm.

5 Click «OK» to exit the dialog.

1

2

3

4

5
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The right segment will also be covered by a door.

1 Click the right part of the case.

2 Select the enclosing segment by clicking .

3 Check the box in front of the «Door » button and click it.

1

2

3

Beginners’ Quick Start Course – Cabinet Design



 

1 Select «Plain door».

2 The door is to be mounted on the «right».

3 Click «OK» to exit the dialog.

1

3

2
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1 Make sure that the handle «_11235» is selected.

2 If the handle is not in the top left corner of the segment, press «Ctrl» and Shift (4) 
and place it there.

n By pressing down Ctrl and Shift, you can place the handle on any place on the 
front. Clicking the same spot repeatedly toggles between horizontal and vertical 
orientation of the handle.

3 The horizontal offset of the handle is «50» mm.

4 The vertical offset of the handle is also «50» mm.

5 Click «OK» to exit the dialog.

1
2

3

4

5
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Textures You are returned to the Cabinet Maker’s main dialog.

In the last step, the textures needed for a photo-realistic rendering are adjusted.

1 Press the «Construction» button in the main dialog.

The «Material…» dialog opens.

Textures are already stored in the template.

2 Change to the «Texture» tab.

3 Select the materials schedule «Default Favorite / interiorcad - Beginners’ 
Quick Start Course» from the pull-down menu.

4 Click «OK» to confirm and exit the dialog.

4

3

2
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Create unit We have now adjusted all the settings necessary for the design of the sideboard. 

1 Click the  button at the bottom of the main dialog.

Move sideboard You are now in the drawing. We can now move the unit we created to its original location.

1 Press «X» to select the tool «2D Selection».

2 Deselect all possibly selected objects by clicking an empty spot on the drawing.

3 Select the sideboard. The Object Info palette shows that the selected object is a «Unit».

4 Press «Ctrl+L» (command «Rotate Left 90°») once so that the unit goes back to its 
original orientation.

1
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5 Double-click the «Move by Points » tool from the «Basic» palette.

6 Make sure that the settings are adjusted as shown:

7 The first mode should be selected.

8 Move the crosshairs to the top left corner of the unit (cue «Point»). This is the starting 
point for the move. (Click 1).

9 Click the top left corner of the room (cue «Endpoint»). (Click 2)

The sideboard is moved to the corner of the room.

The original polygon is now not needed anymore.

1 Press «X» to select the tool «2D Selection».

2 Click the polygon to select it.

3 Press «Del».

Click 1

Click 2
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5 Photo-realistic 
Rendering

In this last part of the beginners’ course, we will create some photo-realistic renderings.

• We add a predefined array of lights and lamps.

• We choose a perspectival view for the scene to be rendered.

• We save the rendering as halftome image.

• You can call further scenes and render them.

Add Lights Just like in the chapter „Place further objects“, the lights for rendering are added from a 
predefined array. This array contains halogen spots fitted to the ceiling, five hanging 
lamps above the reception counter ans a desk lamp. 

o The lights take up quite a lot of rendering time. If you have an older computer with 
a weaker CPU, you can skip the lights and continue with the next chapter.

1 You will find the array as a symbol «Lamps and Lights» in the Resource Browser. 
Double-click it.

2 «Wall Insertion Mode » has to be switched off.

3 Move the insertion point to the bottom outer corner of the left wall, so that the 
cue «Object» is displayed.

4 Doubles-click here.

The lights are added to the drawing.

5 Press «X» to exit adding.

Double-click!
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In this beginners’ course, we only want to give a brief introduction of lights and lamps.

1 Click the button «Right Isometric »in the «Views» palette.

On the room’s ceiling and around the hanging lights, you will see a number of arrow 
points and circles. These symbolize the spots and point lights which we added with the 
symbol «Lamps and lights». There is also a parallel light outside the room, creating the 
effect of sunlight falling through the windows.

n A parallel light is a light of infinite size whose beams run parallel and infinitely in 
one direction. A point light is an infinitely small light whose beams run equally in 
all directions. A spot is a light that can be directed onto a specific spot.

o Lights are never printed. They are only visible on the screen.
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Set 3D View To achieve a natural perspective, we use the command «Set 3D View». This command 
works by defining from which point in the room we would like to look into which direc-
tion.

o If you are not in «Top/Plan» view, press «Ctrl+5» and «Ctrl+4».

1 Choose «View > Set 3D View».

2 The first click determines the beholder’s standpoint. Click where you’d like to stand. 
(Click 1)

3 Then determine in which direction you would like to look and click again. (Click 2) 

After the second click, the «Set 3D View» dialog is opened.

4 The «Viewer Height» is to be «1650» mm.

5 «Look Toward Height» is to be «1600» mm.

6 Select «Normal» perspective.

7 Click «OK» to confirm.

1

Click 1

Click 2

6

7

4
5
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Now you will see something like this:

1 Zoom out of this scene until the entire drawing is visible.

n The black «picture corners» are the border markers of the shown detail. You can 
use the «2D Selection » tool to drag them and make the detail larger or 
smaller. 

2 Drag the corners to select the desired detail.
 Beginners’ Quick Start Course – Photo-realistic Rendering 83



84
Rendering We will now use the tool «Render Bitmap» to create a photo-realistic rendering of the 
detail. The rendering is created as a halftone image inside a frame. This image can then 
be moved around on the drawing, just like any other object. This way, the rendering will 
still be present after you change your viewpoint.

1 Change to the «Visualisation» tool set and select the «Render Bitmap » tool.

The result of the rendering is determined by the resolution in dpi and the selected render 
mode. We will adjust these settings first.

n dpi is short for „dots per inch“.

2 Select the Preferences button in the Tool bar.

The «Preferences Render Bitmap 3D» dialog opens.

3 Select «Final Quality Renderworks».

4 Select «72» DPI.

5 Click «OK» to confirm.

5

3

4
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We now create a frame for the detail you wish to render.

6 Move the cursor to the top left, left-click, and then hold it. (Click…)

7 Drag a frame around the detail to be rendered, then let go of the mous button. (Let 
go!)

Rendering will start immediately after you’ve let go of the mouse.

o Depending on preferences and configuration of Vectorworks and your cmputer, the 
rendering progress will not show up on the screen. In that case, please wait until 
the end of the rendering time. Then the rendered image will be displayed.

o The time required for a rendering depends on your computer’s CPU, the RAM 
available, and the contents of the selected detail. Modern computers should take 
no more than a few minutes for a rendering, but older computers may be signifi-
cantly slower.

n If you are using the demo version, the rendering will have a watermark.

Click…

Let go!
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After your computer has finished calculating, you will see your Vectorworks rendering in 
the drawing.

The halftone image overlays the scene, so we move it to the side.

1 Press «X» to select the «2D Selection » tool.

2 Zoomen Sie aus der Darstellung heraus.

3 Click the halftone image and hold the left mouse button down. (Click…)

4 Move the halftone image to a free spot on the drawing and let go of the mouse button. 
(Let go!)

Let go!Click…
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Call and Render Further
Views

You will find further scenes in the template. You can also create your own 3D views accor-
ding to the principle described above and then render those.

You can access the saved scenes from the View bar. Click the 
«Views » button and select one of the entries in the pull-down menu.

n Select «Save View…» to save further views.

p You can select further Render modes on the View bar.

Congratulations! You made it. You have made the first step on the way to being a skilled Vectorworks user. 
You have learned about the intuitive user interface of Vectorworks and achieved good 
results in a short time. Vectorworks offers you all possibilities of a modern CAD system - 
from fast planning including professional visualisation over simple costings and 
drawings to assembly integration.

In case you have suggestions, or if any of the steps described are unclear to you, please e-
mail me: tobias.lambrecht@extragroup.de or call us on 0049-251-39089-0 an.

Copyright This documentation is copyrighted by international laws. For the use of text, images and 
other elements a written permission of ! GmbH is required.
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